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IMPORTANT NOTICE 

All statements, technical information, and recommendations in this document which relate to the products supplied 

by Meggitt SA are based on information believed to be reliable, but unless otherwise expressly agreed in writing 

with Meggitt SA the accuracy or completeness of such data is not guaranteed. Before using this product, you must 

evaluate it and determine if it is suitable for your intended application. You should also check our website at 

www.meggittsensing.com/energy for any updates to data sheets, Ex certificates, product drawings, user manuals, 

service bulletins and/or other instructions affecting the product. 

Unless otherwise expressly agreed in writing with Meggitt SA, you assume all risks and liability associated with use 

of the product. Meggitt SA takes no responsibility for any statements related to the product which are not contained 

in a current English language Meggitt SA publication, nor for any statements contained in extracts, summaries, 

translations or any other documents not authored and produced by Meggitt SA. 

The certifications and warranties applicable to the products supplied by Meggitt SA are valid only for new products 

purchased directly from Meggitt SA or from an authorised distributor of Meggitt SA. 

Meggitt SA reserves the right to alter any part of this publication without prior notice. 
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PREFACE 

 

About these release notes 

This document provides important information about the VibroSight® software from Meggitt SA. It is applicable to all 

VibroSight-based condition monitoring systems using the versions of software described by this document, namely: 

 VibroSight software version 5.0.0 (CD part number 609-004-000-048). 

This document contains information about changes to the software since the previously released version 

(VibroSight 4.1.x), such as new features and improvements, solved problems and bug fixes, and hardware and 

software compatibility. 

For more general information on the actual software, or the entire condition monitoring system (CMS), refer to the 

following Meggitt SA documentation: 

 VibroSight® software data sheet 

        (Doc. ref. 660-020-005-218A) 

 Getting started with VibroSight® installation guide 

        (Doc. ref. 660-010-006-227A) 

 VibroSight® help 

 VM600 XMV16 / XIO16T extended vibration monitoring card pair data sheet 

        (Doc. ref. 660-020-010-208A) 

 VibroSight application notes and technical notes. 

 

Users who are familiar with VibroSight may also find it useful to refer to the release notes included in earlier 

versions of the software: 

 VibroSight 4.1.0 (Doc. ref. 660-010-013-228A) 

 VibroSight 4.0.0 (Doc. ref. 660-010-013-227A) 

 VibroSight 3.8.0 (Doc. ref. 660-010-013-226A) 

 VibroSight 3.7.0 (Doc. ref. 660-010-013-225A) 

 VibroSight 3.6.0 (Doc. ref. 660-010-013-224A) 

 VibroSight 3.5.0 (Doc. ref. 660-010-013-223A) 

 VibroSight 3.4.0 (Doc. ref. 660-010-013-222A) 

 VibroSight 3.3.0 (Doc. ref. 660-010-013-221A) 

 VibroSight 3.2.0 (Doc. ref. 660-010-013-220A) 

 VibroSight 3.1.0 (Doc. ref. 660-010-013-219A) 

 VibroSight 3.0.0 (Doc. ref. 660-010-013-218A) 
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 VibroSight 2.12.7 (Doc. ref. 660-010-013-217A) 

 VibroSight 2.12.6 (Doc. ref. 660-010-013-216A) 

 VibroSight 2.12.5 (Doc. ref. 660-010-013-215A) 

 VibroSight 2.12.4 (Doc. ref. 660-010-013-214A) 

 VibroSight 2.12.3 (Doc. ref. 660-010-013-213A) 

 VibroSight 2.12.2 (Doc. ref. 660-010-013-212A) 

 VibroSight 2.12.1 (Doc. ref. 660-010-013-211A) 

 VibroSight 2.12.0 (Doc. ref. 660-010-013-210A) 

 VibroSight 2.11.6 (Doc. ref. 660-010-013-209A) 

 VibroSight 2.11.5 (Doc. ref. 660-010-013-208A) 

 VibroSight 2.11.4 (Doc. ref. 660-010-013-207A) 

 VibroSight 2.11.3 (Doc. ref. 660-010-013-206A) 

 VibroSight 2.11.2 (Doc. ref. 660-010-013-205A) 

 VibroSight 2.11.1 (Doc. ref. 660-010-013-204A) 

 VibroSight 2.11.0 (Doc. ref. 660-010-013-203A) 

 VibroSight 2.10.1 (Doc. ref. 660-010-013-201A) 

 VibroSight 2.10.0 (Doc. ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.7 (Doc. ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.6 (Doc. ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.5 (Doc. ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.4 (Doc. ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.2 (Doc. ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.1 (Doc. ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.0 (Doc. ref. VIBROSIGHT-RN/E). 

 

Structure of the release notes 

This document presents information in the following order: general items first, then in terms of the software 

modules that constitute VibroSight, such as  Configurator,  Event Viewer,  Mimic,  Scope, 

 Server,  System Manager and  Vision. 

You should read those sections that are most relevant to you and then keep the document for future reference. 
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Version identifiers 

A complete VibroSight software version number has four components that provide the following information: 

 x.x.x.x, major release identifier – typically incremented once per year. 

 x.x.x.x, minor release identifier – incremented for each release with typically four scheduled releases per 

year. 

 x.x.x.x, “hotfix” release identifier – 0 for a normally scheduled release and incremented for each hotfix 

release. 

 x.x.x.x, software build number – for internal use. 

For each scheduled release of VibroSight, at least one of the first two digits changes (x.x.x.x). 

For unscheduled “hotfix” releases, which are occasionally required to solve urgent problems, the third digit changes 

(x.x.x.x). 

The version identifiers for installed software appear in the Help About box (obtained using Help > About … in any 

VibroSight software module). 

 

Terminology 

To distinguish between the different Meggitt SA products that can be used with the VibroSight® software, the 

following terminology is used in this document: 

 VM600 card – to refer to the VibroSight-software compatible cards that are installed in a VM600 rack. The 

currently available VM600 cards that are designed for operation with the VibroSight software are the 

XMx16 card pairs (XMC16 / XIO16T, XMV16 / XIO16T and 

XMVS16 / XIO16T) and the CPUx card pairs (CPUR2/IOCR2 and CPUR/IOCR). 

Where XMx16 card is used in this document, it refers to XMC16 / XIO16T, XMV16 / XIO16T and XMVS16 / 

XIO16T cards, unless otherwise stated. 

Where CPUx card is used in this document, it refers to CPUR2/IOCR2 and CPUR/IOCR cards, unless 

otherwise stated. 

 VibroSmart® module or VibroSmart® device – to refer to VibroSight-software compatible modules or devices 

that are used in a distributed monitoring system. The currently available VibroSmart modules and devices 

that are designed for operation with the VibroSight software are the VSI010, VSN010 and VSV30x. 

Where VibroSmart module is used in this document, it refers to the VSI010 and VSV30x modules, unless 

otherwise stated. 

Where VibroSmart device is used in this document, it can refer to the VSN010 device only, or to the VSI010 

and VSV30x modules and the VSN010 device, unless otherwise stated. 
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1 Licensing 

Since VibroSight 4.0.0, the ability to install and run VibroSight software updates and upgrades depends on the 

purchased “Updates and support” package. 

NOTE: VibroSight 5.0.0 is a major level release and a new license key file is not required 

for updates and upgrades from VibroSight 4.x.x. 

However, a new license key file is required for updates and upgrades from 

VibroSight 3.8.x or earlier. 

 

For further information on licensing or to obtain a new VibroSight license key file, contact Meggitt SA customer 

support. See 7 Customer support. 

 

2 Features 

General 

2.1 Support for the next generation of VM600 machinery protection system (VM600 MPSG2) 

VibroSight 5.0.0 introduces initial support for the latest version of VM600 machinery protection system, that is, 

support for the new generation (G2) of machinery protection cards, consisting of: 

 The new MPC4G2 and IOC4G2 machinery protection card pair 

 The new RLC16G2 relay card. 

 

These new VM600 MPSG2 cards will debut in April 2020. 

 

NOTE: In order to distinguish between the different VM600 machinery protection systems 

(MPSs) the part number of each of these cards must be checked. 

VibroSight is compatible with: 

 The new MPC4G2 card with part number 600-041-000-VVV.  

 The new IOC4G2 card with part number 600-043-000-VVV.  

 The new RLC16G2 card with part number 600-044-000-VVV. 

VibroSight remains not compatible with previous generations of the MPC4, IOC4 

and RLC16 cards which are still managed using the MPS software. 
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New VM600 MPSG2 software 

The new VM600 MPSG2 cards (MPC4G2/IOC4G2 and RLC16G2) and systems are configured, operated and 

managed using the VibroSight software. 

Accordingly, the VibroSight software now includes a new module (client application) dedicated to the configuration 

of the new VM600 MPS cards/systems, called VibroSight Protect. 

 

NOTE: The VibroSight Protect software is distinct and separate from 

VibroSight Configurator in order to ensure the segregation of machinery protection 

systems (MPSs) and condition monitoring systems (CMSs) when both are installed 

in the same VM600 rack (for example, as required by API 670). 

In this way, MPS and CMS use separate configuration tools with separate output 

configuration files which are also uploaded and activated separately. 

So it is simply not possible for access and/or changes to the CMS 

(VibroSight Configurator) to interfere in the operation of the MPS 

(VibroSight Protect), whether by accident or intent.  

 

The other existing VibroSight software modules are used for the operation and management of the new VM600 

MPS cards in the usual manner. For example, VibroSight Vision is used to display measurements using its 

extensive plot library, VibroSight System Manager is used to update firmware and download log files, and so on. 

 

Previous generation of VM600 MPS software 

The previous generation of VM600 MPS cards (MPC4/IOC4T and RLC16) and systems are configured, operated 

and managed using the legacy VM600 MPSx software. 

NOTE: The VM600 MPSx software is distinct and separate from VibroSight in order to 

ensure the segregation of machinery protection systems (MPSs) and condition 

monitoring systems (CMSs) when both are installed in the same VM600 rack 

(for example, as required by API 670). 

In this way, MPS and CMS configurations use separate tools with separate output 

configuration files. So it is simply not possible for access and/or changes to the 

CMS (VibroSight) to interfere in the operation of the MPS (VM600 MPSx), whether 

by accident or intent.  

 

 

2.2 New maths library 

In order to improve functionality and performance, VibroSight 5.x.x changed the maths library used by the 

VibroSight software to implement the ‘Mathematical outputs’ application specific package. 
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The ‘Mathematical outputs’ application specific package allows a VibroSight Server to perform ‘math’ post-

processing on the data available in its data repository in order to calculate and create new data and information. 

NOTE: A new licence key file is required to enable optional packages, such as 

Mathematical outputs. 

 

 

As a result of this maths library change, the behaviour of the following operators changed: 

 >  (that is, the ‘greater than’ operator) 

 <  (that is, the ‘less than’ operator). 

 

(The > and < operators are still available but the output will no longer change between 0 (FALSE) and 1 (TRUE) 

when used in expressions.) 

 

As a result, in VibroSight 5.x.x, the > and < operators can no longer be used to implement conditional/control 

expressions such as if-then or if-then-else, which now require the use of the ifthen(,,) function: 

ifthen(,,)  

where 

if then(a,b,c) returns b if a is TRUE (that is, not zero); otherwise returns c. 

 

Accordingly, existing VibroSight applications using the optional ‘Mathematical outputs’ package’s > and < operators 

to implement conditional/control expressions must be updated manually, as VibroSight cannot do this 

automatically. 

More specifically, VibroSight Configurator must be used to manually edit Basic math processing blocks using 

> and < operators to implement conditional/control expressions to use an equivalent ifthen(,,) function. 

Once the configuration is activated (applied) to a VibroSight Server and Basic math is enabled in the usual way, the 

VibroSight Server is ready to generate and provide the ‘Mathematical outputs’ using the updated conditional/control 

expressions. 

 

 

VibroSmart modules 

2.3 VSI010 communications interface module: new firmware 

The VibroSight software now includes the latest version of VSI010 communications interface module firmware with 

the following improvements: 



 

RELEASE NOTES 

VibroSight® 5.0.0 

12 / 53 

Document reference VIBROSIGHT-RN/E (660-010-013-229A) 

Version 29A – 16.04.2020 

 

 Module lock mode via spare DSI (multi-purpose) 

The VSI010 module now can be locked by connecting to ground the spare multi-purpose DSI (Digital Signal 

Input). When the module is locked the following actions are not allowed: 

 Configuration change 

 Firmware change 

 Change of time synchronization settings 

 Change of network settings 

 

This new feature brings additional protection against unintended interference over the network as 

recommended by API670. 

 

NOTE: When the multi-purpose DSI is left disconnected the VSI010 module remains 

unlocked. 

In order to simplify the wiring in measurement blocks composed of multiple 

modules, if the DSI master module within a VibroSmart measurement block is 

locked then all other VibroSmart modules in the block will be automatically locked 

as well. 

 

 Support for IEC61850 GOOSE protocol 

The VSI010 module supports now the IEC61850 GOOSE (Generic Object Oriented Substation Event) 

communication interface in addition to the existing Modbus and Profibus communication interfaces. IEC 61850 

is an international standard defining communication protocols for intelligent electronic devices at electrical 

substations. It is a part of the International Electrotechnical Commission's (IEC) Technical Committee 57 

reference architecture for electric power systems. The GOOSE protocol can run over TCP/IP networks or 

substation LANs using high speed switched Ethernet to obtain the necessary response times below four 

milliseconds for protective relaying. 

 

NOTE: The GOOSE interface communicates via the Ethernet ports in the VSB010 module 

base and not via the VSF002 Ethernet fieldbus communications adaptor. 

The Modbus and Profibus communication interfaces still require the use of the 

VSF002 Ethernet fieldbus communications adaptor or the VSF001 serial fieldbus 

communications adaptor. 

The VSI010 module supports the GOOSE and Modbus or Profibus interfaces being 

used in parallel. 

 

 Support for Modbus function code 03 
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The VSI010 module’s implementation of the Modbus fieldbuses (Modbus RTU and Modbus TCP) now supports 

Modbus function code 03 Read holding registers in order to better support third-party systems such as a DCS 

or PLC. For example, many PLCs only support Modbus FC03 to access the 0x4xxxx address space. 

(Previously, only Modbus function code 04 (FC03) − Read Input registers was supported.) 

 

NOTE: Modbus function codes 03 and 04: 

• Function code 03 − Read holding registers 

Holding registers are the most universal 16-bit register, may be read or written, and 

may be used for a variety of things including inputs, outputs, configuration data, or 

any requirement for "holding" data. 

• Function code 04 − Read Input registers 

Input registers are 16-bit registers used for input, and may only be read. 

 

Note: When configuring a Modbus port using VibroSight Configurator, the Published measurements (data) are 

always displayed as “Memory space: Input registers (FC04x)” even though the data is made available using either 

Modbus function codes 03 and 04. It is also important to note that the VSI010 module’s implementation of Modbus 

function codes 03 and 04 are read only. 

 

See also 5.3.1 Module firmware. 

 

 

2.4 VSV30x monitoring module: new firmware 

The VibroSight software now includes the latest version of VSV30x monitoring module firmware with the following 

improvements: 

 Fully configurable tacho ratios 

For an auxiliary input channel configured as a tacho input, a “Conversion ratio” (a software divider) can now be 

configured for a tacho channel in order to better support operation with gearboxes and/or multi-tooth wheels. 

The Conversion ratio consists of the following configurable parameters at the tacho processing block mode 

level: 

o “Multiplier” (numerator)– an integer in the range 1 to 2,147,483,647 

o “Divider” (denominator) – an integer in the range 1 to 2,147,483,647. 

From the “Multiplier” and “Divider”, VibroSight Configurator calculates and displays the “Ratio” and the 

“Converted pulses per revolution”, i.e. “Ratio” × “Number of teeth” which is the actual tacho ratio that is applied. 

 

NOTE: This new configurable tacho ratio is in addition to the “Number of teeth” (a 

hardware divider) which is configured at the input channel node level. 
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 Flexible input channel to processing block mapping 

There is now a 1:n relationship between input channels and processing blocks in order to allow the two 

different processing blocks of a VSV30x module to use the same input channel. Basically, this allows signal 

routing to be done internally by the VSV30x, reducing the requirement for external wiring when an input signal 

is shared. 

(Previously, there was a direct 1:1 relationship between the dynamic input channels and processing blocks, 

that is, input channels could not be routed internally to more than one processing block and external wiring was 

required to share an input signal.) 

 Up to two tacho processing blocks 

It is now possible to configure two tacho processing blocks for a VSV30x module, for example, in order to allow 

signals from related shafts to be more easily monitored and compared. 

(Previously, only one tacho processing block could be configured.) 

 Narrow band vibration for AC coupled input channels 

Narrow band vibration processing is now allowed for AC coupled dynamic input channels. In previous 

VibroSight versions AC+DC coupling was enforced by a consistency check. As a result of this change it is now 

possible to perform a narrow band processing for bearing absolute sensors (accelerometers and velocity 

sensors). 

 Support for pre-trigger and post-trigger data logging 

The VSV30x module supports now pre-trigger and post-trigger data logging in the Alarm Event based data 

logging rule. The pre-trigger maximum size is 50 seconds of trend data, waveforms, spectra and orbits with a 

resolution in time of every 100 ms. The 50 seconds maximum buffer size with a 100 ms data resolution in time 

is fixed and not configurable. 

 Module lock mode via spare DSI (multi-purpose) 

The VSV30x module can now be locked by connecting to ground the spare multi-purpose DSI (Digital Signal 

Input). When the module is locked the following actions are not allowed: 

 Configuration change 

 Firmware change 

 Change of time synchronization settings 

 Change of network settings 

 Channel bypass using VibroSight 

 Trip multiply using VibroSight 

 Alarm bypass using VibroSight 
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NOTE: When the multi-purpose DSI is left disconnected the VSI010 module remains 

unlocked. 

In order to simplify the wiring in measurement blocks composed of multiple 

modules, if the DSI master module within a VibroSmart measurement block is 

locked then all other VibroSmart modules in the block will be automatically locked 

as well. 

 

See also 5.3.1 Module firmware. 

3 Solved problems and bug fixes 

3.1 General improvements and bug fixes 

General stability improvements and bug fixes across the VibroSight 5.0.0 software. 

 

3.2 The mathematical processing block converts the inputs to the reference unit 

The VibroSight mathematical processing block wrongly converts the input data entities to the reference unit of the 

physical quantity before applying the mathematical expression configured. With this fix input data entities 

amplitudes are used in the mathematical expression as they are without making any conversion. 

 

3.3 Display issue prevents configuring alarms in the basic math processing block 

After this fix the Configurator window allows to scroll down in order to configure alarm limits for the basic math 

processing block. 

 

3.4 Configuration activation error when using 2 VSI010 Modbus ports 

The consistency checks in the VibroSight Configurator for the VSI010 communication ports have been 

implemented as follows: 

 Up to 2 serial ports 

 1 Ethernet port  

Note that it is not allowed to mix serial and Ethernet adapters. 

 

3.5 Wrong purple color in the machine state chart 

A display issue that results in the display in Vision plots of purple color machine states has been fixed. 
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3.6 Automatic connection error in Mimic 

An issue has been fixed that prevented working Mimic projects to be copied over to another VibroSight Server 

having the same name and configuration. 

 

3.7 Error message when opening airgap plots in Vision 

An issue resulting in error messages when trying to open airgap plots in Vision has been fixed. 
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4 Known issues 

4.1 Display of timestamps in VibroSight Vision 

In VibroSight Vision, when the timestamps (date and time) are configured to be displayed as Site time or Local 

computer time and the site time or local computer time is subsequently changed on the relevant computer (for 

example, using Windows > Control Panel > Date and Time), this change is not reflected in the VibroSight Vision 

user interface until the user clicks on the Timestamp displayed in the VibroSight Vision status bar. 

 

 

4.2 VibroSight Server and Host Service restart required after changes to network adapter 

If the configuration of a network adapter is changed (for example, enabled or disabled, connected or disconnected) 

on a computer running VibroSight, then the VibroSight Servers and Host Services running on the computer must 

be restarted in order for the network adapter to be recognized by the VibroSight discovery mechanism. 

 

 

4.3 Length limitation of VibroSight Server instance names 

Since VibroSight 2.9.6, VibroSight Server instance names are limited to 18 characters, whereas up to 

27 characters were allowed in previous versions. This constraint is enforced during the creation of new server 

instances with VibroSight 2.9.6 or later. 

NOTE: VibroSight allows only alphanumeric characters (A to Z, a to z, 0 to 9), the 

hyphen-minus character ( - ) and the underscore character ( _ ) to be used for 

VibroSight Server names. 

 

However, existing server instances may be non-compliant (too long) and no longer run after an upgrade of the 

VibroSight software. In such cases, the file names used for a VibroSight Server database file (*.vssrvdb or 

*.db) and a VibroSight Server configuration file (*.vssrvcfg or *.config) should be updated (and manually 

edited in the VibroSight configuration file) to be 18 characters or less. Changes may also be required in any 

VibroSight software that references the server instance name, such as VibroSight Vision projects. 

Where used, the automated data management commands and operations that append a timestamp 

(_yyyyMMddHHmmss) to the Server instance name reduces the number of file name characters that remain 

available for VibroSight Server instance names to three. Alternatively, the server instance name can be shorted 

after the data repository command or operation is complete. 

Also, depending on the VibroSight Server data repository (database) file names used and any truncation performed 

by VibroSight, it is possible that servers are created with names that contain non-allowed characters (such as 

spaces), with the result that these servers will not be accessible by VibroSight software clients. Similarly, duplicate 

VibroSight Server names are also possible. 
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NOTE: Choose appropriate VibroSight Server names in order to avoid name conflicts 

arising due to truncation and/or additional data repositories being created during 

automatic data management. 

This is particularly important for systems with automated data management and 

system backup procedures that can generate VibroSight Server data repositories 

with different file names. 

 
 

4.4 Display of timestamps in VibroSight clients other than VibroSight Vision 

Although VibroSight Vision now supports the display of timestamps (date and time) as either Site time, UTC time or 

Local computer time, all other VibroSight client software modules continue to display timestamps in local computer 

time only (that is, the date and time according to the local clock of the computer running the VibroSight software 

module). 

 
 

4.5 Display of devices in VibroSight System Manager 

In the System Explorer window of VibroSight System Manager, the Devices tree-view does not always update 

correctly to show all of the devices (VM600 cards and VibroSmart devices) available on the network. 

In particular, this has been seen when changing the firmware of a device, and can persist even after a refresh 

(using the Refresh toolbar button or View > Refresh). 

If this behaviour is seen, the recommended workaround is to: 

 Wait a few minutes and refresh again. 

 Restart VibroSight System Manager. 

 
 

4.6 VibroSight Mimic backwards compatibility 

VibroSight 2.10.0 contained significant improvements and changes, including a separate VibroSight Mimic client 

software module for mimics (that were previously available in VibroSight Vision). As a result, VibroSight Vision 

mimics created with VibroSight 2.9.7 or earlier are not compatible with VibroSight 2.10.0 or later. 

VibroSight 2.11.0 contained significant improvements and changes to the VibroSight Mimic client software module. 

As a result, VibroSight Vision mimics created with VibroSight 2.10.1 or earlier are not compatible with VibroSight 

2.11.0 or later. 

VibroSight 2.11.5 contained significant improvements to the VibroSight Mimic project framework to include version 

information, in order to improve the compatibility between projects created with different versions of VibroSight 

Mimic and eliminate the requirement for the recreation of Mimics. Starting with VibroSight 2.11.5, Mimic projects 

automatically detect any changes in the VibroSight Mimic software that affect project compatibility, inform the user 

and update the project as required. 
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NOTE: VibroSight 2.11.5 is also able to open and work with Mimic projects created with 

VibroSight 2.11.0 or later, if the corresponding database had been updated as 

required. 

 

NOTE: When updating existing machinery monitoring projects created with 

VibroSight 2.12.x to VibroSight 3.x.x or later, a new data repository created by 

copying a VibroSight database (*.vssrvdb) to a VibroSight historical data folder 

(*.vshdf) must use the same server file name as the existing server in order for 

existing VibroSight Mimics to maintain links with the data repository and continue to 

work (without manual corrections). 

In addition, the VibroSight Server using the new data repository must be running 

before the existing VibroSight Mimics are run for the first time, after the update. 

 

 

4.7 VibroSight OPC Clients not recovering 

When a VibroSight OPC Client is being used to import information from an external OPC server into a VibroSight 

system and the external OPC server becomes unavailable, the VibroSight OPC Client may not always recover 

automatically when the OPC server becomes available again. 

This is typically characterised by the VibroSight OPC Client continuing to show connection error messages even 

when OPC server is available and can result in permanent loss of the imported data if not noticed. 

NOTE: The external OPC data can be permanently lost if it is not imported into VibroSight 

as expected. 

Any VibroSight system feature or configuration element relying on the imported 

OPC data will not behave as expected, for example, alarms, machinery operating 

conditions and data logging rules. 

 

If this behaviour is seen, the recommended workaround is to: 

 Stop and restart the VibroSight OPC Client from either the VibroSight Server 

(Data > Acquisition > OPC Device Driver) or VibroSight System Manager. 

 Stop and restart the VibroSight Server, if required. 

 

 

4.8 Duplicate events 

For VibroSight systems using VM600 XMx16 cards, VibroSight Event Viewer retrieves all of the event information 

available from the data buffers on the cards. 

For VibroSight systems using VibroSmart modules, VibroSight Event Viewer retrieves the event information 

available from the current time only (no buffered events). 
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Accordingly, for a VibroSight system using VM600 XMx16 cards, there is the possibility of duplicate events being 

listed in the Event Viewer, particularly for VibroSight systems being operated without an NTP server (where events 

are not recognised as duplicates due to time drift). 

 

 

4.9 VibroSight Server status indicators 

The status indicators (performance counter monitors) on the Status tab of the new VibroSight Server are not 

correctly displayed and updated when an NVIDIA WMI driver is installed on the same computer as the VibroSight 

Server. 

NOTE: The NVIDIA Enterprise Management Toolkit (NVWMI) is a graphics and display 

management and control technology that interfaces to Microsoft’s Windows 

Management Instrumentation (WMI) infrastructure, specific to NVIDIA graphics 

processing units (GPUs). 

 

This is because NVIDIA WMI prevents the Microsoft .NET Framework from obtaining the required counter values 

from the underlying operating system / computer. 

 

 

4.10 XMx16 card pre-logging 

For an XMx16 card pair, if Dynamic Input Channel 16 is used as an input to a Dynamic Processing Block that is 

used as an input to a Dual Shaft Relative Processing Block which is configured to provide an Orbit and/or Full 

Spectrum output, then any pre-logging configured for the principal mode Waveform and/or Spectrum of Dynamic 

Input Channel 16 will not actually log any of the data from the same pre-logging scope. 

 

 

4.11 Problems creating new VibroSight OPC Classic Servers 

Users who have upgraded from an earlier version of VibroSight to a later version (for example, from 

VibroSight 2.x.x or 3.0.0 to VibroSight 3.1.0) can experience problems when creating new VibroSight OPC Classic 

Servers. 

Such problems are typically characterised by the OPC Server Create command in VibroSight System Manager 

displaying an error message such as 

“The type initializer for ‘ch.VibroMeter.Xms.OpcServer.Utils.OpcServerUtils’ threw an 

exception”. 

This typically occurs because an earlier version of the OpcServer.config file required by VibroSight OPC 

Classic Servers is being used by the later installation of VibroSight, which can happen in one of two ways: 

 When a version of VibroSight 3.x.x or later is installed on a computer that was running a version of 

VibroSight 2.x.x or earlier, the VibroSight installer automatically checks existing VibroSight folders (such as 

C:\ProgramData\Meggitt\VibroSight 2) in order to copy relevant system and/or user preference files across to 
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the new VibroSight folders (such as C:\ProgramData\Meggitt\VibroSight), including an earlier 

OpcServer.config file. 

 When VibroSight 3.1.0 is installed on a computer that was running VibroSight 3.0.0, the creation of a 

VibroSight OPC Classic installer using VibroSight 3.0.0 automatically created an earlier OpcServer.config 

file. 

As shown below, the first few lines of a typical OpcServer.config file contains version specific information that is 

incompatible with later versions of VibroSight: 

<?xml version="1.0" encoding="utf-8"?> 

<configuration> 

  <configSections> 

    <section name="opcServersConfiguration" 

type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, XmsOpcServerUtils, 

Version=2.0.0.0, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

  </configSections> 

… 

</configuration> 

 

So for users who have upgraded from an earlier version of VibroSight to a later version, if problems are 

experienced when creating new VibroSight OPC Classic Servers, the workaround is to: 

 

1. Use an XML-compatible text editor program to edit the OpcServer.config file and remove the version specific 

information. That is, change the line containing the section name 

from: 

<section name="opcServersConfiguration" 

type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, XmsOpcServerUtils, 

Version=2.0.0.0, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

to: 

<section name="opcServersConfiguration" 

type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, XmsOpcServerUtils, 

Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

 

2. Restart the computer. 

    Note: The computer must be restarted to ensure that the edited version of the OpcServer.config 

    file is used (and not some other version from cache memory). 

 

3. Use the OPC Server Create command in VibroSight System as required. 
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NOTE: The manual migration of existing VibroSight OPC Classic Servers to 

VibroSight 3.x.x or later is described in detail in the “VibroSight OPC Classic Server 

migration” section of the latest  Getting started with VibroSight installation 

guide. 

 

 

4.12 Potential TCP port 50000 conflict 

The VibroSight Host Service (XmsHostService.exe) requires TCP port 50000 for communication with the 

VibroSight software. So if the computer running the VibroSight software is running other software which also 

requires TCP port 50000, this results in a TCP port conflict which can prevent VibroSight (or the other software) 

from running. 

During the VibroSight software installation process, the VibroSight 3.4.x or later installer will typically detect other 

software on the computer that is using TCP port 50000 and report this. For example: “The port 50000 cannot be 

used. Please close all application using this port before manually starting the host service.” 

Accordingly, any potential TCP port 50000 conflicts should be resolved before the VibroSight software can be 

successfully installed and run. 

 

 

4.13 Problems using shared network drives/locations for VibroSight data management 

On computers running Windows 10 or Windows Server 2016, problems can be experienced using shared network 

drives/locations with VibroSight’s integrated data management operations such as Offline data storage and 

Database backup (configured in VibroSight Configurator) due to Windows security policies and restrictions. 

Such problems are typically characterised by the individual copy commands scheduled and run on a VibroSight 

Server (corresponding to Offline data storage and Database backup operations) failing to run correctly. More 

specifically, on the Data Management tab of a VibroSight Server, scheduled incremental copy jobs (Type: Copy) 

are typically displayed with Status: Error, while the Log Messages tab of the server display typically displays 

messages such as “Errors during the copy operation” and “Uncaught error IOException 

occurred in task ‘Task “DataRepositoryCopyDataMan…”. 

NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security 

with a change to the rules governing shared network drives/locations. 

More specifically, a shared network drive/location is now only accessible and 

visible to the user who created the shared network drive/location, even if the user is 

an Administrator. 

 

Accordingly, in order to avoid such problems, a shared network drive/location on Windows 10 and 

Windows Server 2016 computers that is required to be used by VibroSight’s integrated data management 

operations should be created as a “system account” in order to ensure that the required Windows Services can 

access the shared resource (drive/location). 
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This can easily be done using Microsoft’s PsExec utility. For example, by running the following command (as an 

Administrator): 

PsExec.exe -i -s cmd.exe /C "net use Z: \\server\share"  

Where the net use command is used to map the \\computer name\sharename (\\server\share) to the 

devicename (Z:). 

 

NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security 

with a change to the rules governing shared network drives/locations. 

More specifically, a shared network drive/location is now only accessible and 

visible to the user who created the shared network drive/location, even if the user is 

an Administrator. 

 

 

4.14 Problems installing VibroSight 3.7.x on computers without internet access 

On computers which are not connected to the internet, the VibroSight 3.7.x installer can experience problems when 

automatically installing the prerequisite Microsoft Visual C++ Redistributable Package for Visual Studio 2015, and 

report a generic message such as “Setup Failed. One or more issues caused the setup to fail”. 

As a workaround, trying to manual install the Microsoft Visual C++ Redistributable Package for Visual Studio 2015, 

the Microsoft Visual C++ installer can also experience problems, and report a similar generic “Setup Failed” 

message. 

This is a known Microsoft problem which is due to some components in Visual Studio being signed by a 

certification authority that is not installed on the computer, and the computer cannot automatically download the 

required certificate(s) because it is not connected to the internet. 

Accordingly, the Microsoft solution is to: 

1. On a computer which is connected to the internet, download the following certificate: 

http://www.microsoft.com/pki/certs/MicRooCerAut2011_2011_03_22.crt  

Then copy the certificate to the VibroSight computer (for example to C:\Temp). 

2. On the VibroSight computer, use the certmgr.exe utility to add the certificate by using the command line. 

Note: For more information, refer to the Certmgr.exe (Certificate Manager Tool) topic at MSDN. 

3. Open an admin command prompt and run the following command: 

certmgr.exe /add C:\Temp\MicRooCerAut2011_2011_03_22.cer /s /r localMachine root 

4.  Next, try installing the patch KB3135996 or KB3136000. 

 

If required, additional information is available from a Microsoft MSDN blog, here: 

https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-

authority-2 

  

https://docs.microsoft.com/en-us/sysinternals/downloads/psexec
https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-authority-2
https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-authority-2


 

RELEASE NOTES 

VibroSight® 5.0.0 

24 / 53 

Document reference VIBROSIGHT-RN/E (660-010-013-229A) 

Version 29A – 16.04.2020 

 

5 Compatibility 

As part of the VibroSight software installation process, the VibroSight installer will automatically check to see if the 

required Microsoft .NET Framework, Microsoft Visual C++ Redistributable Package, OPC Core Components 

Redistributable software and OPC UA Local Discovery Server are pre-installed on the computer: 

 The required Microsoft Visual C++ Redistributable Package (see section 5.1.3) must be manually installed 

before VibroSight can be installed. If it is not detected, then the VibroSight installer will exit the installation and 

VibroSight is not installed. 

 The required Microsoft .NET Framework (see section 5.1.2) is automatically installed by the VibroSight installer 

if it is not detected. 

 The required OPC Core Components Redistributable (see section 5.1.4) software is automatically installed on 

the computer by the VibroSight installer if it is not detected. 

 The required OPC UA Local Discovery Server (see section 5.1.5) software is automatically installed on the 

computer by the VibroSight installer if it is not detected. 

NOTE: Refer to the latest version of the  Getting started with VibroSight installation 

guide or the  VibroSight software data sheet for further information on 

VibroSight’s prerequisites and compatibility. 

 

5.1 VibroSight software 

VibroSight 5.0.0 is a mayor level release and replaces VibroSight 4.1.x. 

Compatibility with existing VibroSight data repositories (databases) is achieved using a specific data migration 

process from any existing databases based on Sybase SQL Anywhere (*.vssrvdb) to data repositories based on 

the VibroSight historical data repositories (VibroSight historical data folder (*.vshdf) for operation with a 

VibroSight Server (live data) and VibroSight historical data archive (*.vshda) for operation with historical data). 

Compatibility with existing VibroSight machinery monitoring projects using VibroSight OPC Servers that were 

created using VibroSight 2.12.7 or earlier is achieved using a specific VibroSight OPC Server migration process for 

these VibroSight OPC Servers. 

Therefore, it is important to note that: 

 New machinery monitoring projects created with VibroSight 5.x.x (VibroSight 3.x.x or later) will automatically 

use VibroSight historical data repositories. 

 Existing machinery monitoring projects created with versions of VibroSight earlier than VibroSight 3.0.0 must 

be manually migrated from Sybase SQL Anywhere databases to VibroSight historical data repositories before 

they can be used with VibroSight 5.x.x (VibroSight 3.x.x or later). 

 Existing machinery monitoring projects using VibroSight OPC Servers that were created with versions of 

VibroSight earlier than VibroSight 2.12.7 must manually migrate their VibroSight OPC Servers before they can 

be used with VibroSight 5.x.x (VibroSight 3.x.x or later). 

It is very important to note that migrating a VibroSight OPC Server from VibroSight 2.12.7 or earlier to 
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VibroSight 5.x.x (VibroSight 3.x.x or later) or later requires that certain steps must be performed using the 

existing version of VibroSight (that is, VibroSight 2.12.7 or earlier) BEFORE it is removed (uninstalled). 

NOTE: The manual migration of an existing machinery monitoring project to 

VibroSight 5.x.x (VibroSight 3.x.x or later) or later is described in detail in the 

“Data migration” and “VibroSight OPC Server migration” sections of the latest  

 Getting started with VibroSight installation guide. 

 

5.1.1 Microsoft Windows operating systems 

VibroSight 4.x.x (VibroSight 3.x.x or later) or later is compatible with 32-bit versions and 64-bit versions of 

Microsoft ® Windows ® operating systems. 

NOTE: Starting with VibroSight 3.0.0, VibroSight software is now available as 64-bit 

software for 64-bit Windows and 32-bit software for 32-bit Windows. 

The 64-bit version of VibroSight can be installed on 64-bit Windows computers 

only. The 32-bit version of VibroSight can be installed on 32-bit Windows 

computers only. Only a single version of VibroSight can be installed and exist on a 

computer at any one time 

 

See the Appendix of these release notes for further information on VibroSight software and Windows operating 

system compatibility. 

 

5.1.2 Microsoft .NET Framework 

For most Windows operating systems, VibroSight 5.x.x (VibroSight 3.7.0 or later) requires that the Microsoft .NET 

Framework 4.7.2 or later is installed. 

NOTE: VibroSight 5.x.x requires Microsoft .NET Framework 4.7.2. 

 

If the required Microsoft .NET Framework is not pre-installed, then the VibroSight installer will detect this and 

automatically install it as part of the VibroSight software installation process. 

See the Appendix of these release notes for further information on VibroSight software and Microsoft .NET 

Framework requirements. 

 

5.1.3 Microsoft Visual C++ Redistributable Package 

VibroSight 5.x.x (VibroSight 3.x.x or later) requires that the Microsoft Visual C++ Redistributable Package for Visual 

Studio 2015 is installed, in order to install and register the Visual C++ libraries used by VibroSight. 

NOTE: The 64-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 

Visual C++ 2015 Redistributable (x64)”) must be installed on 64-bit Windows 

computers. 

The 32-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 
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Visual C++ 2015 Redistributable (x86)”) must be installed on 32-bit Windows 

computers. 

If the required Microsoft Visual C++ Redistributable Package is not pre-installed, then the VibroSight installer will 

detect this and exit the installation. 

 

5.1.4 OPC Core Components Redistributable 

VibroSight 5.x.x (VibroSight 3.x.x or later) requires that the OPC Core Components Redistributable is installed, in 

order to configure and run VibroSight OPC Clients and VibroSight OPC Servers correctly: the redistributable must 

be installed on OPC client computers in order to allow connections to remote OPC servers and it must be installed 

on OPC server computers in order to allow OPC clients to browse for running OPC servers. 

NOTE: The 64-bit version of the OPC Core Components Redistributable (“OPC Core 

Components Redistributable (x64) 106.0”) must be installed on 64-bit Windows 

computers. 

The 32-bit version of the OPC Core Components Redistributable (“OPC Core 

Components Redistributable (x86) 106.0”) must be installed on 32-bit Windows 

computers. 

 

If the required OPC Core Components Redistributable is not pre-installed, then the VibroSight installer will detect 

this and automatically install it as part of the VibroSight software installation. 

 

5.1.5 OPC UA Local Discovery Server  

VibroSight 5.x.x or later requires that the OPC UA Local Discovery Server is installed, in order to expose OPC UA 

servers for discovery and enable communications with OPC UA clients. 

If the required OPC UA Local Discovery Server is not pre-installed, then the VibroSight installer will detect this and 

automatically install it as part of the VibroSight software installation. 

 

5.1.6 Sybase SQL Anywhere 11 software 

VibroSight 5.x.x (VibroSight 3.x.x or later) does not include any Sybase SQL database software. 

Starting with VibroSight 3.0.0, the VibroSight historical data repositories (VibroSight historical data folder 

(*.vshdf) for operation with a VibroSight Server (live data) and VibroSight historical data archive (*.vshda) for 

operation with historical data) are exclusively used for the required data repositories. 

A VibroSight database based on Sybase SQL Anywhere (*.vssrvdb) can no longer be used as a data repository. 

Accordingly, the Sybase SQL Anywhere 11 database software is no longer included and distributed as part of the 

VibroSight software. 
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NOTE: VibroSight 3.x.x or later exclusively uses data repositories based on the VibroSight 

historical data system. 

VibroSight 2.12.7 used data repositories based on Sybase SQL Anywhere 

databases and introduced initial support for working with data repositories based 

on the VibroSight historical data repositories for data analysis. 

VibroSight 2.12.6 or earlier exclusively used data repositories based on Sybase 

SQL Anywhere databases. 

 

NOTE: The manual migration of an existing machinery monitoring project to 

VibroSight 5.x.x (VibroSight 3.x.x or later) is described in detail in the “Data 

migration” section of the latest  Getting started with VibroSight installation 

guide. 

 

5.1.7 Dell Backup and Recovery software 

Some Dell™ computers running versions of Dell Backup and Recovery software can experience problems running 

the VibroSight software, characterised by the VibroSight software not running or running incorrectly. This is 

because the Dell Backup and Recovery software can use a version of SQLite and associated libraries (DLLs) that 

prevent the VibroSight Host Service from running correctly. 

For example, VibroSight clients can stop running (crash), VibroSight clients can be unable to connect to data 

sources and/or VibroSight System manager may not display all of the commands expected to be available in the 

Actions window. 

If this behaviour is seen, the recommended workaround is to uninstall the Dell Backup and Recovery software. 

NOTE: It is recommended to install and use VibroSight 3.x.x or earlier on a computer that 

does not have Dell Backup and Recovery software installed. 

 

5.1.8 MatrikonOPC software 

Both MatrikonOPC™ software and the VibroSight software can be installed and run on the same computer. 

However, if the MatrikonOPC software is installed after the VibroSight software, this can result in problems related 

to credentials (access rights). These problems are typically characterised by an unhandled exception in VibroSight 

Configurator when trying to configure an OPC device in the Hardware view or an unhandled exception in a 

VibroSight Server when trying to handle/process OPC data. 

MatrikonOPC software and the VibroSight software must be installed on the same computer in the following order: 

1. Install the MatrikonOPC software. 

2. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2010 (version 40219). 

Note: This redistributable package is required by the MatrikonOPC software. 
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3. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2015 (version 23026 or later). 

Note: This redistributable package is required by the VibroSight software. 

4. Install VibroSight 3.x.x or later. 
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5.2 VM600 cards 

5.2.1 Card firmware 

There are no firmware upgrades for VM600 cards corresponding to VibroSight 5.0.0 but the addition of the newly 

supported MPC4G2 card. 

 

The latest firmware for the CPUR2 card remains: 

 Base System: base-system-640-014-001-003.tgz 

 Applications: applications-640-015-001-003.tgz. 

 

The latest firmware for the CPUR card remains: 

 Base System: base-system-640-011-001-005.tgz 

 Applications: applications-640-012-001-005.tgz. 

 

NOTE: In order to help distinguish between VM600 CPUx cards, VibroSight 4.x.x uses 

the following terminology: 

• CPUR2 to refer to the latest version of the CPUx card with support for 

PROFIBUS (PNR 600-026-000-VVV). 

• CPUR to refer to the earlier version of the CPUx card with support for 

Modbus RTU/TCP and card pair redundancy (PNR 600-007-000-VVV). 

(Previously, VibroSight 2.12.7 to 3.8.x used CPUR to refer to the CPUx card with 

PROFIBUS but VibroSight 4.x.x now refers to this card as the CPUR2.) 

 

 

The firmware for the new MPC4G2 card is: 

 640-025-001-000.Mpc4g2Fw 

 

NOTE: This version of MPC4 firmware is compatible with the new MPC4G2 cards with part 

number 600-041-000-VVV. Note that it is not compatible with previous generations 

of the MPC4 card which are still managed using the MPS software. 

 

 

The latest firmware for the XMC16, XMV16 and XMVS16 cards remains: 

 Base System: base-system-640-003-001-016.tgz 

 Applications: applications-640-010-001-016.tgz. 



 

RELEASE NOTES 

VibroSight® 5.0.0 

30 / 53 

Document reference VIBROSIGHT-RN/E (660-010-013-229A) 

Version 29A – 16.04.2020 

 

 

Therefore, for current versions of VM600 cards, firmware upgrades are not required. 

 

 

5.3 VibroSmart devices 

5.3.1 Module firmware 

There are some firmware upgrades for VibroSmart modules and devices corresponding to VibroSight 5.0.0. 

 

The latest firmware for the VSI010 module is now: 

 642-002-000-012.xmsifw. 

See 2.3 VSI010 communications interface module: new firmware for details of improvements to this latest VSI010 

firmware. 

 

The latest firmware for the VSN010 device remains: 

 642-004-000-011.redboxfw. 

 

The latest firmware for the VSV30x modules is now: 

 642-001-000-018.xtranfw. 

See 2.4 VSV30x monitoring module: new firmware for details of improvements to this latest VSI010 firmware. 

 

Therefore, for current versions of VibroSmart modules and devices, firmware upgrades are required. 
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6 Upgrade procedure 

This section describes the procedure for upgrading a VibroSight system from a previous version. Perform the steps 

in the given sequence in order to complete a system upgrade. 

NOTE: It is strongly recommended to verify the version of firmware running in the related 

hardware (XMx16 cards and VibroSmart modules and devices) before starting a 

VibroSight system upgrade, in order to establish if any firmware updates are also 

required. 

See 6.2.3 Updating the firmware using VibroSight System Manager. 

 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 

VibroSmart is available before updating the firmware of any of the VibroSmart 

modules used in the distributed monitoring system. See 6.2.3 Updating the 

firmware using VibroSight System Manager. 

 

 

6.1 VibroSight software user settings 

The VibroSight Software generates and uses some files on the storage device of the computer running VibroSight 

to keep track of user-configurable settings, so that these settings are remembered and applied for the VibroSight 

installation. 

These settings files have an .xmssettings file name extension and on a computer running Windows 7, can be 

found here: 

C:\Users\username\AppData\Roaming\Meggitt\VibroSight, where username is the Windows account name. 

For example, the VibroSightVision.xmssettings file records the user-configurable default settings for 

VibroSight Vision, such as default settings for plots. 

NOTE: VibroSight software updates and upgrades do not replace these settings files, so: 

• For a computer on which VibroSight was previously installed, an update, upgrade 

or a re-installation of VibroSight will continue to use the previous defaults recorded 

in the .xmssettings files. 

• For a computer on which VibroSight was not previously installed, the installation 

of VibroSight will generate and use new .xmssettings files, which use the latest 

VibroSight software defaults. 

If a settings file is deleted for any reason, VibroSight will generate and use a new 

settings file, which uses the latest VibroSight software defaults. 
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6.2 Updating VibroSight-compatible hardware 

Appropriate files and tools are included in the installation package to allow VM600 cards (XMx16) and VibroSmart 

devices (VSI010, VSN010 and VSV30x) to be updated to the latest firmware, in order to take advantage of 

improvements to the VibroSight software. 

Updating the firmware VM600 cards or VibroSmart devices is a special task that can, if used unintentionally or 

incorrectly, lead to malfunctioning of the device and affect proper function of data acquisition. 

During the firmware update of a device, the card or module being updated cannot provide its normal machinery 

monitoring functions because its outputs (alarms and relays) can go to undetermined states, irrespective of how 

they have been configured. 

For VibroSmart modules, the machinery being monitored is not protected for the duration of a firmware update and 

the restart (reboot) that is triggered automatically after the firmware update (which can take up to 5 minutes). 

NOTE: It is highly recommended that firmware updates are only performed in accordance 

with the operating procedures for the machinery being monitored and that 

appropriate precautions are taken at the control system level (such as DCS 

or PLC). 

For example, alarms and relay outputs should be ignored (bypassed or inhibited) in 

order to avoid false trips of the machinery being monitored. 

 

6.2.1 VM600 card firmware 

The latest VM600 card firmware files are copied to a directory on your computer as part of the VibroSight software 

installation process. 

NOTE: For example, the default firmware directory for VM600 cards is: 

C:\Program Files\Meggitt\VibroSight\Firmware\VM600 

 

The firmware files for a VM600 card can be found in the appropriate subfolder and identified by their .tgz file name 

extension. For example, the XMV16 subfolder contains the applications and base system firmware for use by 

XMV16 cards. Any additional firmware updates received from Meggitt SA should also be stored in these 

directories. 

Table 1 shows the compatibility between VibroSight software and VM600 CPUR2 card hardware (that is, CPUR2 

firmware). 

Table 2 shows the compatibility between VibroSight software and VM600 CPUR card hardware (that is, CPUR 

firmware). 

Table 3 shows the compatibility between VibroSight software and VM600 MPC4G2 card hardware (that is, 

MPC4G2 firmware). 

Table 4 shows the compatibility between VibroSight software and VM600 XMx16 card hardware (that is, XMC16, 

XMV16 and XMVS16 firmware). 
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NOTE: It is strongly recommended to use the most recent version of the VM600 CPUR 

firmware and VM600 XMx16 firmware that is compatible with the version of 

VibroSight software being used. 
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Table 1: VibroSight software and VM600 CPUR2 firmware compatibility 

 VM600 CPUR2 firmware  See note 1 

VibroSight software version 

CD part number 

Base-system (*.tgz) 

640-014-001-001 640-014-001-002 640-014-001-003 

Applications (*.tgz) 

640-015-001-001 640-015-001-002 640-015-001-003 

3.1.0 

609-004-000-038 
   

3.2.0 

609-004-000-039 
   

3.3.0 

609-004-000-040 
   

3.4.0 

609-004-000-041 
   

3.5.0 

609-004-000-042 
   

3.6.0 

609-004-000-043 
   

3.7.0 

609-004-000-044 
   

3.8.0 

609-004-000-045 
   

4.0.0 

609-004-000-046 
   

4.1.0 

609-004-000-047 
   See note 2 

5.0.0 

609-004-000-048 
   

 

Notes for Table 1 (see the next page)  
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Notes for Table 1 

1. VM600 CPUR2 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-014-001-xxx for 

the Base System and 640-015-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 

in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR2 card, the dialog box displayed 

by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-014-000-xxx 

for the Base System and 640-015-000-xxx for the Firmware, which correspond to the actual unpacked firmware that is running on the card. 

 

2. This version of VM600 CPUR2 firmware includes improvements such as overall performance, responsiveness and stability, and support for 

CPUR2/IOCR2 card pair relays, and the ability to download the GSD file directly from the card. A firmware upgrade is strongly recommended 

but is not required in order to run VibroSight 4.1.0 or later. 

Note: VibroSight 4.1.0 or later must be used in order to download the VM600 CPUR2 GSD file directly from the CPUR2 card. 
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Table 2: VibroSight software and VM600 CPUR firmware compatibility 

 VM600 CPUR firmware  See note 1 

VibroSight software version 

CD part number 

Base-system (*.tgz) 

640-011-001-004 640-011-001-005 

Applications (*.tgz) 

640-012-001-004 640-012-001-005 

4.0.0 

609-004-000-046 
 See note 2  

4.1.0 

609-004-000-047 
  See note 3 

5.0.0 

609-004-000-048 
  

 

Notes for Table 2 

1. VM600 CPUR firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-011-001-xxx for 

the Base System and 640-012-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 

in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR card, the dialog box displayed by 

the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-011-000-xxx for 

the Base System and 640-012-000-xxx for the Firmware, which correspond to the actual unpacked firmware that is running on the card. 

 

2. This is the latest official release of VM600 CPUR firmware (that is, the earlier version of the CPUx card with support for card pair redundancy 

(PNR 600-007-000-VVV)), which was discontinued in VibroSight 2.12.0 and reintroduced in VibroSight 4.0.x). 

 

3. This version of VM600 CPUR firmware includes a bug fix for a known VM600 CPUx time counter wraparound (overflow) issue and the 

addition of relay outputs to the diagnostics logs. A firmware upgrade is strongly recommended but is not required in order to run VibroSight 4.1.0 

or later. 
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Table 3: VibroSight software and VM600 MPC4G2 firmware compatibility 

 VM600 MPC4G2 firmware (*.Mpc4g2Fw)  See note 1 

VibroSight software version 

CD part number 
640-025-001-000 

5.0.0 

609-004-000-048 
 

 

Notes for Table 3 

1. This version of MPC4 firmware is compatible with the new MPC4G2 cards with part number 600-041-000-VVV. Note that it is not compatible 

with previous generations of the MPC4 card which are still managed using the MPS software. 
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Table 4: VibroSight software and VM600 XMx16 firmware compatibility 

 VM600 XMx16 firmware  See note 1 

VibroSight software version 

CD part number 

Base-system (*.tgz) 

640-003- 

001-014 

640-003- 

001-016 

Applications (*.tgz) 

640-010- 

001-014 

640-010- 

001-016 

3.1.0 

609-004-000-038 
  

3.2.0 

609-004-000-039 
  

3.3.0 

609-004-000-040 
  See note 2 

3.4.0 

609-004-000-041 
  

3.5.0 

609-004-000-042 
  

3.6.0 

609-004-000-043 
  

3.7.0 

609-004-000-044 
  

3.8.0 

609-004-000-045 
  

4.0.0 

609-004-000-046 
  

4.1.0 

609-004-000-047 
  

5.0.0 

609-004-000-048 
  

 

Notes for Table 4 (see the next page)  
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Notes for Table 4 

1. VM600 XMx16 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-003-001-xxx for 

the Base System and 640-010-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 

in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 XMx16 card, the dialog box displayed by 

the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-010-000-xxx for 

the Firmware and 640-003-000-xxx for the Base System, which correspond to the actual unpacked firmware that is running on the card. 

 

2. This version of VM600 XMx16 firmware includes relaxed constraints for dynamic data retention time, that is, optimised memory to reduce the 

possibility of missing data in data intensive VibroSight applications running on less powerful computers. A firmware upgrade is required in order 

to run VibroSight 3.3.0 or later. 
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6.2.2 VibroSmart device firmware 

The latest VibroSmart device firmware files are copied to a directory on your computer as part of the VibroSight 

software installation process. 

NOTE: The default firmware directory for VibroSmart devices is: 

C:\Program Files\Meggitt\VibroSight\Firmware\VibroSmart 

 

The firmware files for a VibroSmart device can be found in the appropriate subfolder and identified by their .*fw file 

name extension. For example, the VSV30x subfolder contains the firmware for use by VSV30x modules. Any 

additional firmware updates received from Meggitt SA should also be stored in these directories. 

Table 5 shows the compatibility between VibroSight software and the VibroSmart VSI010 firmware. 

Table 6 shows the compatibility between VibroSight software and the VibroSmart VSN010 firmware. 

Table 7 shows the compatibility between VibroSight software and the VibroSmart VSV30x firmware. 

 

NOTE: It is strongly recommended to use the most recent version of the VibroSmart 

firmware that is compatible with the version of VibroSight software being used. 
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Table 5: VibroSight software and VibroSmart VSI010 firmware compatibility 

 VSI010 firmware (*.xmsifw)  See note 1 

VibroSight software version 

CD part number 
642-002-000-009 642-002-000-010 642-002-000-011 

3.0.0 

609-004-000-037 
 See note 2 

See notes 

2 and 3 
 

3.1.0 

609-004-000-038 
   

3.2.0 

609-004-000-039 
   

3.3.0 

609-004-000-040 
   

3.4.0 

609-004-000-041 
   

3.5.0 

609-004-000-042 
   

3.6.0 

609-004-000-043 
   

3.7.0 

609-004-000-044 
   

3.8.0 

609-004-000-045 
   

4.0.0 

609-004-000-046 
   

4.1.0 

609-004-000-047 
   

5.0.0 

609-004-000-048 
  

See notes 

2 and 4 

 

Notes for Table 5 (see the next page)  
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Notes for Table 5 

1. VibroSmart VSI010 firmware is distributed as a single .xmsifw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 

PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 

displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 

running on the device. 

 

2. Updating to this version of VibroSmart VSI010 firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time Ethernet 

switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight System 

Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after updating the 

firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 

installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 

VibroSight Configurator can be used to obtain a copy of the configuration as follows: 

• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 

VibroSight Server. 

• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 

the configuration directly from the VibroSmart modules. 

Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSI010 modules) and run the 

Change Firmware command. 

When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 

multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 

devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 

successfully …” message, click the Finish button to continue. 

If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 

close the window and continue. 

Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 

device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 

available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 

If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 

Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSN010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 

VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 

Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 

operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 

ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 

 

3. This version of VibroSmart VSI010 firmware has no limit on the number of constants per VSI010 module. 

A firmware upgrade is recommended but is not required in order to run VibroSight 3.8.0 or later. 

 

4. This version of VibroSmart VSI010 firmware adds support for module lock mode via the multi-purpose DSI, support for IEC61850 GOOSE 

protocol and for Modbus function code 03. A firmware upgrade is recommended but is not required in order to run VibroSight 5.0.0 or later. 
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Table 6: VibroSight software and VibroSmart VSN010 firmware compatibility 

 VSN010 firmware (*.redboxfw)  See note 1 

VibroSight software version 

CD part number 
642-004-000-011 

3.0.0 

609-004-000-037 
 See note 2 

3.1.0 

609-004-000-038 
 

3.2.0 

609-004-000-039 
 

3.3.0 

609-004-000-040 
 

3.4.0 

609-004-000-041 
 

3.5.0 

609-004-000-042 
 

3.6.0 

609-004-000-043 
 

3.7.0 

609-004-000-044 
 

3.8.0 

609-004-000-045 
 

4.0.0 

609-004-000-046 
 

4.1.0 

609-004-000-047 
 

5.0.0 

609-004-000-048 
 

 

Notes for Table 6 (see the next page)  
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Notes for Table 6 

1. VibroSmart VSN010 firmware is distributed as a single .redboxfw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 

PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 

displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 

running on the device. 

 

2. Updating to this version of VibroSmart VSN010 firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time Ethernet 

switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight System 

Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after updating the 

firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 

installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 

VibroSight Configurator can be used to obtain a copy of the configuration as follows: 

• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 

VibroSight Server. 

• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 

the configuration directly from the VibroSmart modules. 

Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

 (2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSN010 modules) and run the 

Change Firmware command. 

When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 

multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 

devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 

successfully …” message, click the Finish button to continue. 

If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 

close the window and continue. 

Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 

device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 

available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 

If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 

Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 

VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 

Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 

operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 

ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
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Table 7: VibroSight software and VibroSmart VSV30x firmware compatibility 

 VSV30x firmware (*.xtranfw)  See note 1 

VibroSight 

software version 

CD part number 

642-001-000-014 642-001-000-015 642-001-000-016 642-001-000-017 

3.0.0 

609-004-000-037 
 See note 2 

   

3.1.0 

609-004-000-038 
 

   

3.2.0 

609-004-000-039 
 

   

3.3.0 

609-004-000-040 
 

   

3.4.0 

609-004-000-041 
 

See notes 

2 and 3 

See notes 

2 and 4 

 

3.5.0 

609-004-000-042 
   

 

3.6.0 

609-004-000-043 
   

 

3.7.0 

609-004-000-044 
   

 

3.8.0 

609-004-000-045 
   

 

4.0.0 

609-004-000-046 
   

 

4.1.0 

609-004-000-047 
   

 

5.0.0 

609-004-000-048 
   

See notes 

2 and 5 

 

Notes for Table 7 (see the next page)  
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Notes for Table 7 

1. VibroSmart VSV30x firmware is distributed as a single .xtranfw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 

PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 

displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 

running on the device. 

 

2. Updating to this version of VibroSmart VSV30x firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time Ethernet 

switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight System 

Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after updating the 

firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 

installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 

VibroSight Configurator can be used to obtain a copy of the configuration as follows: 

• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 

VibroSight Server. 

• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 

the configuration directly from the VibroSmart modules. 

Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSV30x modules) and run the 

Change Firmware command. 

When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 

multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 

devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 

successfully …” message, click the Finish button to continue. 

If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 

close the window and continue. 

Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 

device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 

available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 

If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 

Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSN010 modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 

VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 

Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 

operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 

ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 

 

3. This version of VibroSmart VSV30x firmware adds support for hydro air-gap monitoring. 

A firmware upgrade is required in order to run VibroSight 3.4.0 or later. 

 

4. This version of VibroSmart VSV30x firmware adds support for latched alarms. 

A firmware upgrade is recommended but is not required in order to run VibroSight 3.6.0 or later. 

 

5. This version of VibroSmart VSV30x firmware adds support for fully configurable tacho ratios, flexible input channel to processing block 

mapping, up to two tacho processing blocks, narrow band vibration for AC coupled input channels, pre-trigger and post-trigger data logging and  

module lock mode via the multi-purpose DSI (see 2.4 VSV30x monitoring module: new firmware). A firmware upgrade is required in order to run 

VibroSight 5.0.0 or later. 
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6.2.3 Updating the firmware using VibroSight System Manager 

When performing VibroSight software upgrades, it is strongly recommended to systematically upgrade the firmware 

of VM600 XMx16 cards and VibroSmart devices to the latest compatible version. 

Failure to perform a necessary VibroSight-compatible VM600 card firmware update may lead to incoherent system 

behaviour and affect the proper functioning of data acquisition in a system. It is only in systems where the firmware 

running on the XMx16 cards and VibroSmart devices already corresponds to the latest available version that no 

firmware update is required. Therefore, it is strongly recommended to verify the version of firmware running on the 

hardware before starting a VibroSight system upgrade, in order to establish if a firmware update is also required. 

NOTE: Changing the firmware of the VibroSight hardware is a special administrative task 

that can – if performed unintentionally – affect the proper functioning of data 

acquisition in a system. 

It is therefore strongly recommended to change the firmware of the VibroSight 

hardware only when it is necessary. For example, when the devices must be 

updated to be compatible with a VibroSight software upgrade. 

 

For VibroSmart modules, each module can be selected and its firmware updated individually. Alternatively, multiple 

modules of the same type (for example, VSV3x0) can be updated to the same version of firmware at the same 

time. 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 

VibroSmart is available before updating the firmware of any of the VibroSmart 

modules used in the distributed monitoring system. 

For example, using the currently installed version of VibroSight (that is, before any 

updates to the VibroSight software corresponding to updates to VibroSmart 

modules), VibroSight Configurator should be used to obtain a copy of the 

configuration as follows:  

For a VibroSmart using a VibroSight Server, the File > Open > Server / Database 

command can be used to read the configuration from the VibroSight Server. 

For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” 

VibroSmart), the File > Open > Device command can be used to read the 

configuration directly from the VibroSmart modules. 

Then the File > Save As > File command should be used to store a copy of the 

configuration for the VibroSmart distributed monitoring system. 

 

Update the firmware on a VibroSight device using the  Change Firmware tool (from VibroSight System 

Manager’s Maintenance tools): 

1. Ensure that the computer running the VibroSight software is on the same network as the hardware (XMx16 

card or VibroSmart module or device) to be updated. 

2. Start VibroSight System Manager and navigate to the Devices tree structure in the System Explorer window. 
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The Devices tree lists all of the VibroSight compatible hardware that VibroSight can see on the network. If 

there are no XMx16 cards or VibroSmart devices in the tree structure or some cards are missing, verify your 

network connections. 

3. Select the card or device that requires its firmware to be changed. 

The Actions tool window updates to show the available tools. 

To change multiple VibroSmart to use the same version of firmware at the same time, use CTRL+click or 

SHIFT+click to select multiple devices from the Devices tree-view. (Then, when the Change Firmware 

command is run, all of the devices that were selected will be updated at the same time.) 

4. Click  Change Firmware in the Maintenance tools group of the Actions window. 

The Change Firmware dialog box appears. 

5. Click the Add button and select the new firmware files for the card or new firmware file for the device. 

 NOTE: The Change Firmware dialog box automatically opens the firmware folder 

corresponding to the VibroSight-compatible VM600 card or VibroSmart device 

selected. 

.tgz files are for VM600 cards and .*fw files are for VibroSmart devices. 

 

6. Click the Finish button to start the firmware upgrade process. 

For XMx16 cards and VibroSmart devices, the firmware upgrade process can take up to 5 minutes, during 

which: 

 The IP address beside the device’s serial number in the Devices tree structure can disappear. 

 The LEDs on the front panel of the device can change to reflect the status of the upgrade. 

7. Repeat steps 3 to 6 for each device that requires a firmware update. 

 NOTE: Although the firmware for each VibroSight device must be changed individually 

using the  Change Firmware tool, as each device updates its firmware 

independently of the VibroSight software (once the process has started), firmware 

updates can be performed on several devices in parallel. 

 

8. After the firmware upgrade, verify that the VibroSight system is acquiring data from the cards. 

 NOTE: Refer also to the Changing the firmware topics in the  VibroSight help. 

 

The  Change Firmware tool can be used to load a VibroSight device with any version of firmware. It is 

therefore possible to change a device’s firmware to any previously available version, as well as the latest update. 
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This feature can be useful in certain situations, for example, swapping spare VibroSight hardware between different 

VM600 racks or VibroSmart distributed monitoring systems, where systems are operating with different versions of 

VibroSight. 

 

6.3 Final checks 

After upgrading the VibroSight software, it is recommended to check that VibroSight has not been inadvertently 

modified and that it continues to operate normally. 

 

In particular, it is recommended to check any VibroSight Servers in order to ensure that the data acquisition and 

external interfaces, data post-processing and/or logging are all configured as expected. 

 

In a VibroSight Server user interface: 

 On the Status tab under Device drivers, check that the VM600, VibroSmart, OPC and Modbus controls are 

enabled or disabled as required by your application. 

 On the Status tab under Server features, check that the Basic math, Air gap, Combustion monitoring, Duration 

counters, VSHDA import and Data logging manager controls are enabled or disabled as required by your 

application. 

 On the Log messages tab, check the listed messages (Info level) to ensure that the hardware (VM600 cards 

and /or VibroSmart modules) have been discovered and that data acquisition has resumed. 

NOTE: When a VibroSight Server is running as a Windows service, the usual VibroSight 

Server user interface is not displayed, so VibroSight System Manager must be 

used to work with the VibroSight Server. 

That is, VibroSight System Manager can be used to connect to a VibroSight Server 

in order to check and configure the operation of the server’s drivers and features. 

 

 

Finally, after an upgrade, it is strongly recommended to use VibroSight Vision to connect to any VibroSight Servers 

in order to verify that new live and/or historical data is available. 
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7 Customer support 

7.1 Contacting us 

Meggitt SA worldwide customer support network offers a range of support including Technical support and Sales 

and repairs support. For customer support, please contact your local Meggitt representative. Alternatively, contact 

our main office: 

Customer support  

Meggitt SA 

Route de Moncor 4 

PO Box 1616 

CH-1701 Fribourg 

Switzerland 

 

Telephone: +41 (0) 26 407 11 11 

Email: energysupport@ch.meggitt.com 

Website: www.meggittsensing.com/energy 

 

7.2 Technical support 

Meggitt SA technical support team provide both pre-sales and post-sales technical support, including: 

 General advice 

 Technical advice 

 Troubleshooting 

 Site visits. 

 

7.3 Sales and repairs support 

Meggitt SA sales team provide both pre-sales and post-sales support, including advice on: 

 New products 

 Spare parts 

 Repairs. 

 

 

mailto:energysupport@ch.meggitt.com
http://www.meggittsensing.com/energy
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VibroSight software and Windows operating system compatibility 

 

 

Windows 10 Windows 8.1 Windows 7 

VibroSight software compatible? Yes Yes 

Yes 

(but not recommended for new 

installations as Microsoft support for 

Windows 7 ends in January 2020) 

 

 

VibroSight software and Windows Server operating system compatibility 

 

 

Windows Server 2016 Windows Server 2012 Windows Server 2008 R2 

VibroSight software compatible? Yes Yes 

Yes 

(but not recommended for new 

installations as Microsoft support for 

Windows Server 2008 R2 ends in 

January 2020) 
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VibroSight software and Microsoft .NET Framework requirements 

VibroSight software version Microsoft .NET Framework requirements 

VibroSight 3.7.0 or later .NET Framework 4.7.2 See note 1 

VibroSight 3.4.0 or later .NET Framework 4.7.1 See note 2 

VibroSight 3.0.0 or later .NET Framework 4.6 

VibroSight 2.12.0 or later .NET Framework 4.5 and .NET Framework 2.0 See note 3 

VibroSight 2.9.4 or later .NET Framework 4.5 

VibroSight 2.9.3 and 2.9.2 .NET Framework 4 (Standalone Installer) 

VibroSight 2.9.1 or earlier .NET Framework 3.5 SP1 
 

Notes 

1. Microsoft .NET Framework 4.7.2 replaces .NET Framework versions 4.0 to 4.7.1. 

2. Microsoft .NET Framework 4.7.1 replaces .NET Framework versions 4.0 to 4.7. 

3. Since Microsoft .NET Framework 3.5 also includes .NET Framework 2.0 and .NET Framework 3.0, installing Microsoft .NET Framework 3.5 SP1 is the recommended solution for most computers (rather than 

installing Microsoft .NET Framework 2.0). 

 

 


